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Important Safety Warnings

1. Ensure that your microB (the cable from your PC, USB) is plugged into the front
stub wall of your system before booting FP3002.

2. Ensure that any BNC connections are made before booting FP3002.

3. Prior to turning on your system, decide if you will be using the 450nm or 635nm
laser. If you intend to use the 450nm laser, ensure that you have connected your
secondary patch cord to the FC-FC connector on the front stub wall ( [C] in
diagrams below). Also before turning on the system - make sure that your ribbon
wire is connected to the appropriate laser.

4. Do not ever look directly into a patch cord.

5. Wear the appropriate laser safety goggles when using the lasers.

6. Please prepare your inputs and outputs with care. Input signals should be no
larger than 5V. Do NOT check Out0 and Out1 if you do not intend to record the
state of each LED.
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FP3002 Quick Start Guide

Inside your pelican case, you will find your FP3002. To get started:

1. Remove FP3002 from the Pelican case, and place right-side-up on the table.
2. On the front stub wall, plug your USB-3 adaptor into the top-left port and

connect to a USB-3 port on your computer. Please do NOT use a USB extension
cable, we cannot guarantee that your system will work properly.

3. Plug the power in - and toggle the “ON/OFF” switch in the back to “ON”.
4. The front facing LCD screen will show the system booting up. While this is

happening, open your Bonsai program and make sure your parameters are as
desired.

5. If you intend to use the laser (for opto-stim) during this experiment, be sure to
flip the laser key to “ON”. This key is in the box of accessories inside the Pelican
case.

CAUTION: If you are using a 450nm laser, make sure your second patch cord is
attached to the FC-connector on the front stub wall of FP3002.

6. Screw the appropriate (SMA or FC) connector onto your photometry patch cord,
thread this through the front face of the stub wall, and connect to the carriage
with magnets.

7. The system was shipped to you with the focus locked. Open the lid, and use the
L-hex-key (1.5 mm) to unlock the translator nob, and then the straight hex-key (2
mm) to advance the carriage closer to the objective (i.e. further away from you).
Your focal point should be about 0.5 mm from the objective.

8. You are ready to record!

IMPORTANT: Read the manual and associated safety
instructions prior to use.
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FP3002 Technical Specifications

Acquisition Rate: 1-200 Hz; 80 Hz standard
Absolute Sensitivity Measure: 4.51 (photons needed to equal noise)

OptoStim Lasers:
Red Laser Power Max: ≥10mW from a single 200 µm fiber
Wavelength: 635 nm +/- 5 nm
Blue Laser Power Max: ≥30mW from a single 200 µm fiber
Wavelength: 450 nm +/- 5 nm
Stimulation Frequency: 1-100Hz

Simultaneous Recordings from multiple fibers:
8 branching patch cord (200 µm each)
4 branching patch cord (400 µm each)
*please note, we always recommend
200 µm over 400 µm, and it is critical to ensure that the outer diameter of the bundle
does not exceed 1mm.

LEDs for recording:
415 (isosbestic)*: 0.1 - ≥400 µW
470 (e.g. GCaMP, dLight)*: 0.1 - ≥560 µW
560 (e.g. RCaMP)*: 0.1 - ≥130 µW
Step Size: 25 nW

*min and max through 200 µm fiber

Numerical Aperture: 0.37 - 0.4

Digital Inputs: 2
Digital Outputs: 1 + laser

Timing Synchronization: sub-millisecond synchronization with external equipment
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FP3002 Excitation and Emission Spectra

The FP3002 system comes
with three excitation channels
and is capable of recording
two emission channels.
Throughout this manual the
three excitation channels will
be referred to as the 415nm,
470nm and 560nm channels.
The channels are named
these wavelengths because
each LED emits the highest
intensity at that wavelength.
Because the system is LED
based, excitation spectra is a
band within the following
range for each LED:
415nm LED : 400 - 425nm
470nm LED : 445 - 486nm
560nm LED : 535 - 569nm.

The two
emission
channels will be
referred to as
the red and
green channels.
The emission
channels have
been optimized
to record from
green
fluorescent
proteins and
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red fluorescent proteins. The following is the spectral range for the green and red
emission channels:
Green Emission Channel : 494 - 531nm
Red Emission Channel : 586 - 627nm.
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What is Included in the FP3002 System

Anatomy of the System

Stub Wall
A. USB Out (USB-3 ONLY)
B. Laser Enable/Disable Key Switch
C. 450nm Laser Out, FC Connector
D. General Purpose Input/Output (GPIO - Hirose connector)

E. Timing Synchronization In (1/8 inch Audio connector)
F. Timing Synchronization Out (1/8 inch Audio connector)
G. Digital Inputs (BNC connector)
H. Digital Output (BNC connector)
I. LCD Screen
J. Patch Cord In
K. One Axis Translator Knob

9



Internal Components
L. Power in and on/off switch
M. X/Y Translator for 635 nm Laser
N. Optical Housing
O. Objective (20x, NA = .4)
P. One Axis Translator with Magnetic Connector
Q. Stub Wall
R. LED Housing
S. Electronics Housing
T. 635 nm Fiber Coupled Laser
U. 450 nm Fiber Coupled Laser
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Accessories
❏ Micro - B to USB 3 Cable (3 meters)

❏ Connect the USB plug to a USB 3 port on your computer and connect
the Micro - B plug to port A specified in the diagram above. Please do
NOT use a USB extension cable, we cannot guarantee that your
system will work properly.

❏ ⅛ inch Audio Cable (1 meter)
❏ Connect one side of the cable to either port E or F. The other side of the

audio cable should be connected to another Harp controlled system.
❏ Power Supply Cable

❏ Connect the male grounded plug to a three prong outlet and the female
plug to the Power Supply Brick.

❏ Power Supply Brick
❏ Connect the DC plug to port L.

❏ 1.5mm L-shaped Hex Key
❏ Use to lock or unlock the position of the 1 axis translator. The set screw is

accessible from a top down view of the system, near the handle.
❏ 2mm Straight Hex Key

❏ Thread through hole K to attach to the 1 axis translator knob. Turning
clockwise will translate the patch cord carriage towards the objective.
Turning counterclockwise will translate the patch cord carriage away from
the objective.

❏ Magnetized FC and SMA connector
❏ Connect a patch cord to one of the connectors. Thread through hole J

and connect to the translator carriage.
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Download Software
_____________________________________________________________________________________________________________________

Spinnaker
Follow this link to download
Spinnaker 1.29.05. Version 1.29.05
needs to be installed for Bonsai to
recognize the camera sensor. (Please
use exactly this version). Download
the .exe file and open to run
installation. Follow the installation
instructions, when choosing between
Camera Evaluation or Application
Development choose Camera
Evaluation. Uncheck "I will use GigE
Cameras" and install.

Bonsai
Follow this link to download the newest version
of Bonsai. Follow the installation instructions.
When installation is complete, please click
Launch instead of Close to install all
dependencies. At the start up window, click on
Manage Packages. Under Browse → Package
Source: All, download all packages until the 3rd
page. These packages include: Bonsai Starter
Pack (This will automatically install Arduino,

Audio, DSP, DSP Design, Osc, Scripting, Vision, Vision Design and Window Input),
Bonsai – System, Bonsai – Visualizers, Bonsai – Editor, Bonsai – Core, Bonsai –
Design, Bonsai – Video, Bonsai – System Design, Bonsai – Video Design, Bonsai -
Player, and Bonsai - Spinnaker Library. The FP3002 nodes are found in the Community
Packages. Please search and install the Neurophotometrics, Neurophotometrics
Design and Harp Libraries which can be found under Community Packages. Ensure
that all dependencies are installed, too.

Please read the documentation on the FP3001 Bonsai Nodes linked here.
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How to Update Bonsai
_____________________________________________________________________________________________________________________

Tools needed to update: Your laptop with Bonsai.
Time requirement: Maximum 5 mins.

An update to any installed package is available when this icon is present in your
toolbar. See the image (Image 2) below for a reference as to where the update icon will
be displayed. Please save any open workflows and close out of them. Please left click
once on the icon to open the update manager.

Image 1: Zoomed in image of the Bonsai toolbar. The update icon will be displayed as
the rightmost icon in your toolbar. Hovering over the icon will highlight the icon blue
and display the message “Package updates are available”.

The update manager will open automatically, showing what packages are available.
Note that if you are using a version of Bonsai older than 2.6.0, please ensure that you
are looking at “Stable Only” packages, not “Include Prerelease”. This option can be
found in a drop down menu located to the top left of the package selector, see the
image below (Image 2a) for location reference. You can left click and select “Update”
on individual packages to update packages selectively; however, we recommend left
clicking the “Update All” button. If you are using Bonsai 2.6.0 or newer, please click on
the “Update” tab and left click the “Update All” button (see Image 2b).
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Image 2a: Cropped image of the Update Manager for Bonsai versions older than
version 2.6.0. Note that “Stable Only” updates are displayed.

Image 2b: Cropped image of the Update Manager for Bonsai version 2.6.0. All updates
will be “Stable Only” updates.

A window will pop up to ensure dependencies are also up to date. If you see a
message uninstalling an old package, do not worry as the updated package will be
installed in its place. The window will automatically close and you can exit out of the
update manager to return to the main Bonsai window. You can open a previous
workflow and continue experiments as normal!

Please note that we, the Neurophotometrics team, will send an update email whenever
an update is released. If you do not see the update icon in your tool bar, please
manually access the Update Manager by clicking on Tools > Manage Packages. Click
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on the word Updates to open the Update Manager. If the Update Manager displays the
error “The remote server returned the error. (404) Not Found.” this means that there is a
network connection issue between Bonsai and the Internet. First, please attempt to
resolve the connection issue by checking your connection to the internet. Please
disconnect and reconnect to the Internet if possible.

Image 3: Example of a network connection error in the Update Manager.

If that does not work then access the Package Updater by clicking on Online/Browse.
If this page is able to connect to the Internet, please search for the Neurophotometrics
packages by clicking on Community packages and installing the Neurophotometrics
and Neurophotometrics.Design packages. This will download the most up to date
version.

Update 1.1 — Released January 12th, 2021
Update 1.1 will require you to update your
firmware as well. The firmware will be uploaded
through the FP3002 node. You can use a
previously saved workflow or you can access
your Toolbox and insert a new

FP3002(Neurophotometrics)
node. Please double left click
on the FP3002 node to open up the FP3002 Configuration window.
A pop-up window will appear requesting you update the firmware.
Left click yes. Bonsai will automatically upload firmware and restart
your system. When the system has booted up, you can continue
with your normal experiments. If you are unsure if your system has
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successfully installed this firmware, close out of your FP3002 node and double left
click to open the node again. Hover over the Bonsai logo located on your Windows
toolbar. Select the black screen. Your firmware (Fw) should now say 1.1 instead of 1.0.

Update Functionality: Updates the system firmware. Cross-talk between Digital In
ports is resolved. 470 nm LED power is automatically 0 when opening up the ROI
calibration window.
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Using the New FP3002 Bonsai Nodes
_________________________________________________________________________________________________________

This document will cover all new nodes unique to the FP3002 system, new nodes
include FP3002, Command, DigitalInput, and DigitalOutput. GroupRegions,
PhotometryData, PhotometryWriter and WithLatestTimestamp are compatible with
the FP3002 node and their functionality is detailed in FP3001 Bonsai Documentation.

Differences between FP3001 and FP3002
Unlike FP3001, the first version of the Neurophotometrics multi-fiber photometry
system, FP3002 does not have an external driver box. Instead, your system is driven by
a software interface in Bonsai. The only hardware interface on the FP3002 system is
the ON/OFF switch along with both translators.

Before Starting an Experiment
Plug the micro-B to USB cord into the plug on the stub wall of the system. Then turn
the system on. If you turn the system on before plugging in the USB cord, please wait
for the system to fully boot up before plugging in the USB cord. Open up Bonsai and
either use this template or search for FP3002 in the toolbox and enter it into the
workflow.
To begin, simply click on the FP3002 node once, under properties on the right hand
side of the screen, select the port name of your FP3002 system (COMx). Double click
the FP3002 node to configure your settings.

Load/Save
The top left corner of the FP3002 Setup Window
allows one to save and load settings as an .xlm file.
The top button “Load Device Settings…” will load
a previously saved .xlm file. The middle button
“Save Device Settings…” will save the current
configuration. When clicked, use the directory
window to select the save location of the .xlm file.
Another window will pop up prompting: “Do you want to save the register values on
persistent device memory?” Clicking Yes will save the configuration to the board
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indefinitely. Every time the system is turned on the saved configuration will
automatically populate. Clicking No will save the configuration until the system is
turned off. The next time the system is turned on, the configuration saved to the board
will be loaded; if nothing has been saved to the board, factory settings will be
populated. Please save configurations before starting each recording. Closing out of
the window will not guarantee that your configuration is saved. The bottom button
“Reset Device Settings…” will reset the configuration to factory settings. Please note
that “Save Device Settings…” will save the configurations of the electronics. This
button will not save Regions of Interest (ROI’s). ROIs are saved within the Bonsai file.
Saving a Bonsai file can be done by clicking “File” on the topmost Bonsai toolbar, and
clicking “Save As”.

Setup
The bottom left corner of the FP3002 Setup
Window contains two calibration windows.
The top button “Calibrate Regions…” will open
a window to visualize and define ROI activity.
A graph displaying trace 0 representing the
average pixel value of the entire window will
display. The graph is normalized to the
maximum pixel value, that maximum pixel
value is dependent if the camera’s pixel format
is in Mono 8 or Mono 16. Note that this is how
data are formatted; each data point is the
normalized average pixel value of each ROI.
The x-axis represents time of day (hour,
minute, second) [starting time,∞] and the
y-axis represents a normalized average pixel

value [0,1]. Cursor will display the coordinates your cursor arrow is hovering over
(frame number, normalized average pixel value). Note that this will not “snap” to the
coordinates on the graph. Capacity alters the amount of points displayed. Increase
Capacity to display more data points, decrease Capacity to display less. The bottom
slider bar represents power of the 470nm LED (%). This power will not save when
exiting out of the calibration window and
should be used to aid patch cord alignment.
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The button at the top called Calibrate Regions, will open the ROI Picker. Use this
window to define ROIs. Left click and drag to draw and create new ROIs. To modify an
existing ROI, left click to select an ROI and right click and drag to redefine. To delete an
ROI, left click to select and hit delete on your keyboard. Each ROI should be defined by
a number and a letter, either G or R. Bonsai will automatically detect which ROIs collect
data from the green (G) or red (R) channel based upon a 50/50 split of the field of view.
Exit out of the window and you will now see a trace for all ROIs. Exit out of the window
to save your ROIs.
The middle button, “Calibrate Power…” will open a window with 3 slider bars. Each bar
modulates the amount of amperage sent to an individual LED. This amount is
represented as a percent. To calibrate power, slide one slider to a percent and use a
power meter to configure power. Out of the tip of a fiber, the power should be ~50μW
across all LEDs for a 200um patch cord. This corresponds to ~4% for both the 470nm
and 415nm LED and ~30% for the 560nm LED. Please return the slider back to 0 when
calibrating a different LED. Not doing so will inflate your power readings. When you
close out of the Calibrate Power window, the number the slider is positioned over, will
automatically write to the Power Configuration table.

The bottom button, “Calibrate Laser…” will open
a window to align the 635nm laser. This button
will be blocked unless ‘635’ is typed into the
Laser Wavelength selector. Clicking on the
“Calibrate Laser…” button will open a window
displaying the field of view of the camera. The
bottom left corner configures pulse settings.
PulseCount sets the number of pulses to occur.
Pulse Frequency how often a pulse occurs (in Hz).
Pulse Width is the laser exposure time (ms). The
bottom right corner will allow you to pulse the
laser at the specified pulse settings by clicking on
“Test Stimulation”. Power is automatically set at
10% power. Use the XY Translator to align your
laser to a fiber core. You will configure power
before running the Bonsai workflow.

Configuration
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The configuration panel alters where specified information is routed. The Clock
Synchronizer specifies if data is time locked to “This Device” or to an “External
Device”. This setting will also need to match with the clock in and clock out ports on
the stub wall. If plugged into the clock in, please select “External Device”. If plugged
into the clock out or not plugged in at all, please select “ThisDevice”.

Output1Routing communicates the state of the output port 1 to the specified
selection. This option is implemented as another safety key to the laser. The laser will
not turn on if the state is routed to only BNC. If the state is routed to InternalLaser,
then the BNC will not output data. If the state is routed to Both then both the Internal
Laser and BNC port will function as specified.

Brightness alters the brightness of the screen [0,15]. 0 turns the screen off completely
while 15 is the brightest the screen can go. Please note that if either the 450nm or the
635nm laser is selected the screen will not dim lower than 7.

Digital IO
The Digital IO panel can be used to timelock behavioural equipment/data to the fiber
photometry system. The system comes with two digital input and two digital output
ports.

Digital0Input and Digital1Input take TTLs coming in from an external system. Please
do not send more than 5Vs into the system. EventRising will only acquire the time
point at which the signal changes from LOW to HIGH — active high. EventRising
produces a 1 when the signal changes. EventFalling will only acquire the time point at
which the signal changes from HIGH to LOW — active low. EventFalling produces a 0
when the signal changes. EventChange will acquire the time point the signal changes,

producing a square wave
consisting of 0’s representing a
change from HIGH to LOW and 1’s
representing a change from LOW
to HIGH. StartStimulation will
enable the laser to activate when
the incoming signal is HIGH. You
will not need to configure the laser
settings besides the Laser
Wavelength and Pulse Amplitude.
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Neither will you need the Command node to start Stimulation. StopTrigger, Stop
ExternalCamera, StartTriggerExternalCamera,  ControlTrigger, ControlExternalCamera,

ControlTriggerExternalCamera, ControlStimulation are
works in progress to be available in a future update.

Digital0Output and Digital1Output specifies the output
TTLs source. This signal can range from 0V to 5V, either
positive or negative polarity. This signal can be sourced
from the Software where Bonsai can act as the function
generator via line(s) of code in the workflow. A Strobe
signal can be output from the ports, which sends out a

binary signal whenever the camera is acquiring data. TriggerState will output a binary
signal whenever a specified LED is on. Please select the LEDs to examine on the right
hand window labelled TriggerSequence. Note that Out1 or Out0 and TriggerState for
the respective port need to be checked and selected in order to output a signal for LED
activity. Do NOT check these boxes if you are not recording the LED trigger state.

Photometry
FrameRate can be set within a range of 15-200 using the
dropdown menu slider. The FrameRate establishes the
acquisition rate of the camera in frames per second (fps).
The required frame rate for the fluorophore you are using
depends on the kinetics of the fluorophore itself. If the
camera’s field of view is not cropped, the maximum
frame rate is 80fps. Cropping the field of view will
increase the camera’s acquisition rate. To do this, select
the FP3002 node and on the right hand side under the
‘Properties’ menu, select ‘True’ from the dropdown menu next to ‘AutoCrop’. This will
automatically crop the camera field of view around your selected ROI(s), increasing the
capacity by which the camera can now collect data at the increased frame rate. If
AutoCrop is set to False and an attempt to increase the FrameRate past the camera’s
capability is made, an error will pop up notifying you to either turn down the FrameRate
or set AutoCrop to True.

Trigger State
Trigger state is represented by an array configured on the
right hand side of the FP3002 window called Trigger
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Sequence. The order of the LEDs can be chosen within this window. The order of the
LEDs does not matter, the PhotometryData node will deinterleave the data based
upon the trigger sequence. The LED sequence is sequential rather than simultaneous.
This means that no LED will be active at the same time as another LED, thus your
effective frame rate is the frame rate specified in the Photometry panel divided by the
number of rows in your Trigger Sequence. Selecting only 1 LED will result in that LED
activating constantly, not pulsed. This action is only advised for calibration purposes,
not during recording. Note an LED will not be included in the sequence until a blank
row appears below it, this is achieved by clicking the wavelength from the drop down
menu. To delete an LED in the sequence, select the row and hit delete on the keyboard.
Click on the Out0 or/and Out1 check boxes if you wish to have a record of when the
LEDs are turned on. Please note that for this to be recorded, the DigitalOut selection
will need to be set to TriggerState. Do NOT check these boxes if you are not recording
the LED trigger state.

Power
The Power panel controls the power of the LEDs, respective to their wavelength. The
power is represented in percent of the maximum amperage [0.00%, 100%]. To
calibrate power, you will need to set the percentage and check the power output with a
power meter. Out of the tip of a fiber, the power should be ~50μW across all LEDs. This
corresponds to ~4% for both the 470nm and 415nm LED and ~30% for the 560nm
LED. Power can be set lower or higher, this is dependent on implantation and viral
expression, power should be balanced between good SNR and bleaching rate.

Stimulation
The Stimulation panel should be used to
configure the laser settings. Please note that
the key switch will need to be connected in
order for the laser to be used. The wavelength
will need to be typed into the cell for
LaserWavelength. The wavelength needs to
be exactly either 450 or 635 in order for the
laser to turn on. Additionally every time the
system is booted, you will need to re-enter the
laser wavelength. This setting will not save to
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the system’s memory. Entering 635 will make the “Calibrate Laser…” available.
Entering 450 will pop up a window reminding you to attach the secondary patch cord.
Pulse Amplitude sets the power of the laser in % power [0.00%, 100%]. To calibrate
power, you will need to set the percent and run the workflow. 1-3mW should be
sufficient for opsin stimulation. PulseCount sets the number of pulses to occur. Pulse
Frequency is the time one pulse begins and ends (Hz). Pulse Width is the laser
exposure time (ms).

Bonsai Workflow
In order to start LED activity and data acquisition,
configuring the FP3002 node and playing the workflow is
sufficient. In order to record data, you will need to attach
PhotometryData nodes to specify which deinterleaved
channel to examine and attach a PhotometryWriter at the
end. If no filter is selected in PhotometryData, then the
interleaved signal will be displayed. Note that unlike the
FP3001 node, a PhotometryWriter node cannot be
connected directly to the FP3002 node.

To turn on the laser, a Command node will need to be connected to the FP3002 node
— the laser will not turn on with just the FP3002 node. Please have the laser key
connected to the system and laser wavelength selected in the FP3002 node. There are
many ways to command the laser to turn on, a few easy ways is to use either a
KeyDown node or the Timer node. If using a KeyDown node, select a filter under
properties to define a key that activates the laser. Using a KeyDown node will require

you to press the key every time the PulseCount
completes. If using a Timer (Reactive), the laser will
start at the same time as the start of the workflow. If
using the Timer node, laser activity can be delayed by
setting the DueTime (Hour, Minutes, Seconds). Similar
to the KeyDown node, the laser will turn off after the
pulse count is completed. However, if the Period (Hour,
Minutes, Seconds) is set to a certain time frame the

pulse count will replay until the recording is stopped or a command to stop stimulation
is executed. Within properties, the Command node allows the user to select the Mode,
this defines if the Command Starts or Stops the Type. The Type defines what is being
controlled: Stimulation, External Camera or Photodiode.

23



Connect the DigitalInput node after the FP3002 in order to visualize and record an
input signal. To record the input signal, please use a CsvWriter to save your data.
Please ensure that the FP3002 DigitalIO panel reflects the same information on the
DigitalInput node. A
timestamp can be
included within the
properties by selecting
True or False, the
timestamp is represented
in seconds. The Type can
be specified to define
where information is
routed from, either State,
Input 1 or Input 0. The
DigitalOutput node will
function similarly, but is still a work in progress to synchronize and perform closed loop
paradigms.
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Determining LED Duty Cycle
_____________________________________________________________________________________________________________________

Duty Cycle refers to the ratio of time that a device is on versus the time that it is off
within one period. It is easiest to think of duty cycle as the percent time the device is
on. Within this section, we will discuss how to control the duty cycle of your LEDs
which excite fluorescent indicators such as GCaMP. A decreased duty cycle is
particularly advantageous for overnight recordings. The less time the LED is on, the
slower photobleaching will occur. You should not have to decrease the duty cycle for
recordings shorter than 1-2 hours. To simplify this process, the Neurophotometrics
system modulates the amount of time an LED is on in a given frame by inserting
“blank” frames.

For this, it is easiest to think of the desired frequency/duty
cycle per wavelength. So if for example you are only
interested in imaging in Green with a full duty cycle, you will
set up your LEDs as represented in the image on the right.

You want an effective frame rate of 25Hz per wavelength, you need to set your system
to 50Hz. Keep in mind that the effective frame rate is determined by the interval of time
it takes for a specific LED to complete a frame and turn on at a new frame. At 50Hz
your LEDs will be on for just under 20msec per frame.

Now let’s say that you want the same effective frequency
but a decreased duty cycle of 50% (10msec). You will set up
your LEDs to have blank frames as represented in the image
on the left. Set the frequency to 100Hz. This will still give
you an effective frequency of 25Hz per wavelength, but now
the LED is only on for 10msec.

Because it would be most advantageous to have the
isosbestic control as close to the calcium dependent
recording as possible, we recommend you actually place
the 470 and 415 LEDs consecutively, leaving the two blank
frames at the end, as pictured in the image on the right.
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Connecting and Aligning My Patch Cord

The NPM system is compatible with both FC and SMA connectors and the procedure
for connecting both patch cords to the system is identical. The system is not
pre-focused, this guide will walk you through patch cord alignment. Note that the one
axis translator is locked when shipped. You will need to unlock the translator with a
1.5mm L-hex-key.

1. Screw the patch cord into either FC or SMA-NPM magnetic connector. The end
of the patch cord should be proud of the flat face (opposite the threaded side) of
the connector. Note that the FC connector has an alignment pin and the SMA
connector does not. Please make sure that the pin fits into the pin sized slot
before screwing.

2. Open the lid of the system.
3. Insert the FC or SMA-NPM connector through the “Patch Cord In” [J] port.
4. Fit FC or SMA-NPM connector into the carriage. It is held in place by magnets

and should click into place.

5. Unlock the translator with the 1.5mm L-hex-key. The set screw location can be
found in the image below.
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6. Visualize camera feed in Bonsai.
7. Insert the straight hex-key (2 mm) into hole [K] (please reference page 6 of this

manual) and turn counterclockwise to advance the carriage closer to the
objective (i.e. further away from you). Your focal point should be about 0.5 mm
from the objective. You should see an image of the tip(s) of your patch cord.
Continue to move the carriage until the image looks crisp. You can illuminate
your fibers by tapping or shining light down the tip(s) of the patch cord. An
example of a two branching 200um core FC patch cord is below.

Image 1: Image of an aligned two branched 200um core FC patch cord,
illuminated by tapping on the ends of a patch cord with a gloved finger.
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Laser Alignment

Safety Warnings
● Wear laser safety glasses whenever the laser is in use.
● Please do not look or use optical instruments to look directly at the laser.

This especially applies to your patch cord. Handle the patch cord with care
when the laser is on, please do not shine the tip of the patch cord in a fellow
researcher’s or your own face.

● Remove the laser key after every use. Although there is still a software governor,
please remove the laser key to avoid any accidents.

● To switch between the 635nm and 450nm laser, please turn off the system to
swap cables. Do not unplug and plug in the laser cable while the system is
running.

Laser Configuration
With the FP3002 system, you are able to align the 635nm laser to a single branch on
your multi-branching patch cord. This method allows one to do simultaneous green
channel fiber photometry recordings and red opsin stimulation. The system comes with
a two axis translator (XY translator) to focus your laser beam onto only one branch.
Note that you may be able to split the beam into two branches, but this is not
recommended due to the drastic decrease in power efficiency. This translator can be
found at location M referenced on page 7 of this manual —it is the translator located
nearest to the ON/OFF switch.

To begin, please make sure to first align your patch cord to the system using the one
axis translator. You will not get adequate power output if your patch cord is not aligned.
Next, type in the laser wavelength under the laser settings in the FP3002 configuration
window. You will need to type in ‘635’ exactly. When you press ‘Enter’, the Calibrate
Laser button will activate. Press on the button to align your laser. Within the Calibrate
Laser window, you are only able to configure the Pulse Count, Pulse Frequency and
Pulse Width. For your safety the laser power has been automatically configured to
10%. Configure the parameters per your experiment, the pulse variables will copy over
to the FP3002 configuration window when you exit out of the Calibrate Laser window.
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Laser Alignment
Click ‘Test Stimulation’ to begin pulsing the laser.
You should see the laser show up on the left side of
your screen. Use the knobs on the XY translator to
center the laser beam on a core. To aid alignment,
shine a light (i.e. at the ceiling lights or a flashlight)
down the tip of your patch cord. The external light is
a means to locate your patch cord in the image and
visualize each branch. Ensure that the laser is still
running by checking the LCD screen on the system.
The screen should like the image to the right.

Once you have verified that the laser is on, use the XY translator to point the laser
beam onto an illuminated fiber. Remove the external light when you have selected your
branch. From this point, the laser beam should illuminate the whole fiber. You can fine
tune the laser alignment without the external light.

Image 2: The tips of an 8 branching patch cord were pointed at an external light
source. The laser beam was translated to the middle core.
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Image 3: With the external light source removed, the beam was translated to the
middle of the fiber.

How to Test Laser Power
The integrated lasers on the FP3002 are locked to function when pulsed. Please inquire
if your experiments necessitate CW (continuous wave). Taking power of a pulsed laser
is different from taking power of an LED that is constantly on. Many top tier power
meters will automatically spit out this reading by switching to a different mode;
however, these power meters can cost at least $2,000. As we recommend the Thorlabs
PM100USB power meter (coupled with the S120C sensor), this guide will detail how to
achieve an accurate reading with that power meter. Therefore you will need the
PM100USB power meter, S120C or similar sensor, the Thorlabs Optical Power Meter
software and the FP3002 system.

There is no calibrate laser power button, this will need to be
done by running Bonsai code. Use either of the Bonsai lines
shown on the right to run the laser. We recommend setting the
Pulse Amplitude to 30. This will give you a power of
approximately 1mW out of a 200um fiber. This process may take
a few minutes as you start, stop and alter the pulse amplitude to
meet your desired power output. Note that you will need to turn
LED power to 0 to avoid inaccurate readings. If you have a PhotometryWriter in your
workflow, you can right click and select Disable to avoid saving unnecessary data.
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Access the power meter settings under the Thorlabs
Optical Power Meter application. Since the power meter
will need to integrate data from a slow frequency, you
will need to set your Bandwidth to High (100 kHz). This
will increase the rate of data transfer thereby allowing
you to integrate peak to peak more efficiently. Please
use a Low (20Hz) bandwidth when measuring LED
power as the higher data transfer rate will increase
noise levels. Set Averaging to 1. Any value higher may
result in a value that is averaged with the time that the
laser is off. You can set this to any value, recommended
100, when measuring LED power. Lastly, set
Resolution to Low. Setting the resolution to Low will
decrease the noise level. All other parameters are no
different than the parameters set when taking LED
power measurements. Remember to wear laser safety
glasses when taking power measurements!
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Independence Tests

An independence test examines how much signal of one fiber bleeds into another fiber.
This can vary based upon the polishing of your patch cord therefore independence
tests are important to do every time you align a new patch cord. The test can be done
qualitatively or quantitatively. Tapping one fiber should result in no noticeable signal
change in any other fiber. Accurate independence tests will need to be done post hoc
instead of online. Independence tests are only needed if you are using a branching
patch cord. If your patch cord only has one fiber, an independence test is not needed.
This section will cover how to quantitatively check independence on Excel. This
process can be automated with analysis software, once you understand how an
independence test is conducted. You will need the FP3002 system aligned with a
branching patch cord, an item to cover the tips of your patch cord and an item that is
green and red. We recommend autofluorescent slides, but a smart phone application
displaying coloured light works similarly.

First configure your settings. All settings are negligible except for LED Powers, Trigger
Sequence and Frame Rate. We recommend setting your LED powers to the same
number that you will record with or setting them between 10-20%. We recommend
setting Frame Rate to the lowest setting 16. This is to decrease your file size. Please
select only one LED, either the 470 or 560, in the Trigger Sequence. For this guide we
will examine the green channel so select the 470 LED. You will need to repeat the
following steps for the red channel if you are using a red fluorescent protein. First align
your system with your branching patch cord using the Calibrate Regions window.
Within that same window, draw ROIs over each core for the green channel only. We
highly suggest that you label each branch with a piece of tape or nail polish. Please
note what #ROI corresponds to what branch. Exit out of your ROI picker window and
save your settings.

Return to the Bonsai workflow. You will only need
three nodes for this test: FP3002, PhotometryData
and PhotometryWriter, connected in that order.
Define the save patch in your PhotometryWriter
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node by clicking the ellipsis button. Next prepare for the recording. Grab one branch of
your patch cord and hide all other branches under a cover such that no light will
interfere with them. Play the Bonsai workflow and open the PhotometryData node by
double left clicking. Take your green object and wave it over the tip of the selected
branch. You will want to replicate a square wave. You will not want to saturate the
sensor, so the object should be no less than 6mm from the tip of the patch cord. You
will want to wave at least 5 times. At this point you can stop the workflow, grab another
branch and repeat the process above for all branches.

Open the csv file in
Excel. The goal of an
independence test is to
compare the signal
change of each branch.
For this example, a 4
branching patch cord
was used with 0G
representing the branch
receiving signal. First,
calculate the change
between each frame. In
cell I2 type in ‘=D3-D2’.

You can now hover over to the
bottom right corner of the cell until
a ‘+’ appears. Left click and drag to
apply the formula to the right three
cells. Now highlight the four cells
that you have made and using the
‘+’ to drag them down to the end of
the recording, applying the formula
for all rows. Second, identify the
spots when the jump in signal
occurred. We recommend using
conditional formatting to highlight
cells with a value above 0.1within
column I. Third, you want to
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compare the change in each fiber to the change of fiber 0G. You will want a change
200 times larger in fiber 0G than the change in any other fiber. You can calculate this
ratio by entering ‘=I2/J2’ in cell N2, ‘=I2/K2’ in cell O2, and ‘=I2/L2’ in cell P2. You can
use the ‘+’ to drag and apply this formula to all rows or just apply the formula to the
highlighted rows. This number should be larger than 200. You can reverse this ratio
to determine the percent bleed of one fiber into others. Repeat for all remaining fibers
and the red channel. Note that you will select the 560 LED under Trigger Sequence and
wave the red object in front of the patch cord branch.
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Walkthrough

This section will walk you through a typical GCaMP recording with 635nm laser
stimulation. For details on some of the methods mentioned in this section please look
at the details on the specified pages of this manual. We advise reading the manual
before proceeding with a recording.

1. Plug in the USB to micro B cable. The micro B end will attach to the system. The
USB end will attach to a USB 3 port on your computer. Please do not use a
USB extension cable, we cannot guarantee that your system will work
properly.

2. Plug in the power supply and turn on the system. I
represents ON and O represents OFF.

3. Patiently wait for your system to boot up. Boot up
is complete when you see the image on the right.

4. Open Bonsai and start a new workflow (Reference
page 10 for software details).

5. Access your toolbox and type in ‘KeyDown’.
6. Double left click on KeyDown(Windows.Input).
7. Access your toolbox and type ‘Neurophotometrics’.
8. Left click on the KeyDown node once.
9. Double left click on Command to insert the node into your workflow. Without

clicking on anything else, double left click on FP3002, then double left click on
PhotometryData, then double left click on PhotometryWriter to connect all five
in that order.

10.Attach your patch cord to the one axis translator (Reference page 21 for details).
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11.Access the Calibrate Regions window. Align your patch cord and define ROI’s
(Reference page 14-15).

12.Align your laser and configure laser power (Reference page 23-24).
13.Conduct an independence test if using a new patch cord (Reference page

27-29).
14.Configure settings and LED power within the FP3002 node (Reference page

14-18).
15.Connect your animal with a ceramic sleeve, open Calibrate Power and turn off all

of the room lights. Please ensure that you do not see any light escaping from the
ceramic sleeve. If you see light, fix the connection between the patch cord and
fiber optic cannula.

16.Save your settings and return to the workflow.
17.Press play on Bonsai to begin recording.
18.Press a key on the keyboard to begin pulsing the laser.
19.When the recording is complete, click stop on Bonsai to stop recording.
20. If this is your last recording, exit out of all FP3002 windows first, do not close the

Bonsai black screen. This will automatically close when exiting out of the Bonsai
main window.

21.Turn off the system, unplug the USB cable, remove the laser Key and exit out of
Bonsai. It is very important to unplug the USB cable at the end of each day.
This will avoid overheating of the camera. *If you are running overnight
recordings, this is okay as the camera has an active heatsink to cool it off.
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Troubleshooting

Q: I do not see any of the Neurophotometric nodes in my Bonsai toolbox.
A: Download Spinnaker 1.29.05. You will need this version in order to use any of the
Neurophotometric nodes. See Downloading Software on page 9 of this manual.

If you have installed the correct Spinnaker and still have errors, you may be missing
some drivers. The best thing to do is completely uninstall Bonsai from your computer,
as well as SpinView/Spinnaker.

BEFORE installing those, please install the FTDI drivers:
https://bitbucket.org/fchampalimaud/downloads/downloads/UsbDriver-2.12.26.zip

When you reinstall the others, you would want to make sure that the correct version of
Spinview is installed. Bonsai accesses the camera's data via the Spinnaker app. Follow
the steps for installation, when choosing between Camera Evaluation or Application
Development choose Camera Evaluation. Uncheck "I will use GigE Cameras" and
install.  https://flir.app.boxcn.net/v/SpinnakerSDK/file/622481657674

Q: My Calibrate Laser button is disabled, or my laser will not turn on.
A: You will need to ensure that both laser governors are enabled. First make sure that
the key on your system stub wall is in the slot and turned 90 degrees clockwise. The
second governor is found in the FP3002 calibration window. You need to manually type
in your laser wavelength. This will be 450 or 635. Do not add in any spaces or symbols.
There is not a range, the software will only enable the laser if you type in the exact
wavelength.

Q: My system’s connection to Bonsai keeps on dropping.
A: Most likely your USB connection is faulty - if you have used an alternate USB cable
from that which was provided, this is the cause. Similarly, this can occur if an extension
cord is used.
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Q: How do I save my ROIs so that they are the same each day?
A: ROIs are defined and processed via Bonsai; therefore, your ROI configuration is
saved in the Bonsai file. Even though the ROI configuration can be saved, we
recommend checking ROIs before each experiment as good practice.

Q: I have received a similar error message
located to the right when I click “Calibrate
Regions” or when I run the workflow.

A: If this message pops up when you run the
workflow, please set “AutoCrop” to True.
AutoCrop can be found by clicking on the
FP3002 once and accessing the Properties on
the right hand side of your Bonsai window. If
this message pops up when you click
“Calibrate Regions” this means that the system
has or currently is plugged into a USB 2.0 port
- you have used an alternate USB3 cable - or the
cable is not plugged directly into the computer
(uses an extension cord or USB hub). To remedy
this, you will need to access the SpinView
application. Click once on the camera name
"Blackfly S BFS-U3-51S5M-BD". Under the
"Settings" tab, scroll down to the bottom and on
the slider bar next to "Device Link Throughput Limit" slide it all the way to the right.
Then click on the red circle with an arrow pointing downwards at a camera on the
toolbar. Below is a picture highlighting the red circle to click. Close out of SpinView and
return to Bonsai.
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Q: Where should I save my data and how do I navigate directories?
A: Saving your data in organized directories is a key part of any experiment, else
important experimental data can be lost. When setting up your Bonsai workflow,
double click the writer node that you are using to save data (i.e. “Photometry Writer”,
“CsvWriter”, “VideoWriter”, etc.). This should open your operating system’s “File
Explorer” window. This is what you will use to navigate your directory to choose the
location you want your file to be saved. One basic organizational scheme is to separate
your data by experiment, as shown below.
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In the search bar for the file explorer window, one can see that the path for The
“Experiement1 Data” folder is “C:\Users\CJohn\Documents\FP_Experiments”. Since
this is currently saved on this PC’s SSD, it is inside of the “OS (C:)” drive. However,
sometimes it is beneficial to save elsewhere. For example, if you wish to save data
directly to an external drive, you can navigate all the way out to “This PC” and instead
of selecting the “OS (C:)” drive, you can enter the “D:” drive and save there.

40



Additional Information: Isosbestic Points

In brief:

When you excite many GFP-based indicators with 415-nm light the emission level is
proportional to the number of molecules underneath your implant making it a useful
indicator of photobleaching and some movement artifacts.

More information:

Green fluorescent protein (GFP) can be transiently excited by photons in the blue range
(~470nm). When it relaxes from this unstable state, energy is released in the form of a
photon. Due to conservation of energy, it must have less energy than the photon that
was absorbed – so, it releases a photon in the green range (~520nm). This difference is
known as a Stokes shift.

GFP-based indicators (GCaMP, dLight, GRAB-NE, etc etc) link the ability to fluoresce
(absorb one photon and release another lower energy photon) to a binding event.
Conceptually, in the case of GCaMP, when it is bound to calcium, it behaves similarly
to standard GFP. However, when it is unbound, it is much less fluorescent. This delta
(Fbound – Funbound) is what drives the high signal-to-noise ratio (SNR) of this indicator.1

If you UV-shift the excitation wavelength (i.e. reduce the wavelength), this delta
decreases. At a certain point, known as the “isosbestic point”, the two values are equal
(Fbound == Funbound). An important caveat that we exploit with photometry is that, though
diminished, we still observe fluorescence at this point. So, if we excite GCaMP with a
higher energy photon, we can get an emission signal that does not depend on whether
it is bound to calcium or not. In essence, it behaves like a lower SNR GFP molecule.

1 Barnett, L. M., Hughes, T. E., & Drobizhev, M. (2017). Deciphering the molecular mechanism
responsible for GCaMP6ms Ca2 -dependent change in fluorescence. Plos One, 12(2).
doi:10.1371/journal.pone.0170934
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Why do we care?

In short: The brain is squishy and optics/the skull are not. This mechanical mismatch
leads to movement of neural tissue relative to your implant. Emission levels when
excited at the isosbestic point are only sensitive to the number of GCaMP molecules
beneath your implant – so movement will result in a change in that signal. If we were
only recording the highly calcium-dependent 470 nm-related signal, we would not be
able to determine whether this change was due to movement or a change in the
fraction of molecules that are bound to calcium (Fig. 1). 2

Another important function of this isosbestic control is to quantify the impact of
photobleaching on your recording. Photobleaching is a phenomenon where a
fluorescent molecule loses its ability to fluoresce in a light-dependent manner. More
light leads to faster rates of photobleaching. This is HUGELY important as the same
underlying biological event will produce a larger 470-relative photometry event early on
in a recording compared to later. This can skew your interpretation of the results and
can produce both false positives and false negatives. That’s where the
isosbestic-control comes in handy! As the isosbestic or 415nm-related emission is
proportional to the number of fluorescent molecules beneath your implant, the
emission will decrease as a function of time as more and more molecules lose their
ability to fluoresce. This allows you to correct your raw-470nm-relative emission so as
to make it ONLY dependent on the biochemical event of interest (in the case of
GCaMP, this would be the fraction of molecules that are bound to calcium).

Even more details:

The biophysically inclined will note that the true isosbestic point of GCaMP is closer to
420-425nm. They’ll also know that it is pH dependent and can be a bit of a moving
target across preparations. Any way you slice it, though, 415nm is indeed shorter than
the isosbestic wavelength. So, why did we choose to excite at this wavelength?

2 Motion artifacts of this kind, the brain moving relative to the implant, are relatively rare – accounting for
~5% of those observed in photometry recordings. Their effect size is also fairly small as a photometry
recording is spatially averaging a signal from a volume of tissue (many orders of magnitude larger than a
pixel in a 2-photon recording).
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The delta (Fbound - Funbound) changes asymmetrically about the isosbestic point. If you
red-shift the excitation wavelength, you will quickly see a signal where Fbound >>>
Funbound that will approximate your 470-related signal, just with lower SNR.
Experimentally, this would not be that useful as a control. If you UV-shift the excitation
wavelength from the isosbestic point, as we did, Fbound < Funbound. This delta is quite
small, and for most recordings, the resulting emission is explained by the number of
fluorescent molecules under your fiber more-so than its state (bound or unbound).

Experimentally, this signal serves two purposes.

1) Correcting for photobleaching

2) Validating slow changes in signal

Correcting for photobleaching: For most recordings that are > 10 minutes in length, you
will observe a decay in your 415-related signal that can be fit with a biexponential
decay. If you divide your 470-related data by a linearly scaled version of this fit, you
will, largely, correct for photobleaching.3

Validating slow changes in signal: Photometry is great at detecting relatively fast
(seconds-long) changes in signal related to a discrete event. Things get trickier when
the biochemical event has kinetics that begin to approach those of photobleaching
(10s of minutes). For the purposes of discussion, let’s say we wanted to see a drug
decrease activity in a particular brain region. So, we express GCaMP in this region,
implant a fiber, hook it up to our photometry setup, and we’re off to the races. We
record a 10-minute baseline, then administer the drug. For the purposes of this
discussion, we also happen to be omnipotent and we know that this drug drives the
mean firing rate of neurons in this brain region to decrease, linearly, for 20 minutes and
then plateau.

If we look at the slower kinetics of the 470-related signal, it will always be trending
downward, as photobleaching and the effect of the drug are working in concert to
decrease emission. Without the 415nm control, we would be at risk of the
photobleaching occluding our biological effect resulting in a false-negative result.

3 This is an estimate. The length of the recording required to observe this decay, and to effectively
correct for bleaching, is proportional to your SNR. Higher SNRs require longer recordings to observe a
downward trend in your 470-related signal.
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But we’re savvier than that! We’ve studied the exquisitely dense biophysics literature
on calcium indicators and know that the 415-related signal is slightly more sensitive to
unbound GCaMP, compared to bound. For the 10-minute baseline, our 415-related
signal decreases as a function of photobleaching. However, as the drug begins to take
effect, the fraction of GCaMP molecules that are calcium-bound decreases, and we
observe an inflexion point as our 415-related signal begins to increase. When the4

mean firing rate reaches its lowest point, the 415-related signal no longer increases,
and the main effect is not photobleaching.

We will have to pivot our approach to correcting for photobleaching here depending on
the relationship between the duration of the recording and the duration of the effect.
Looking at the raw data, we can be confident that our effect is real based on the
negative relationship between the 470 and 415nm signals.

How does this relate to red-shifted indicators?

In photometry, red shifted indicators, such a jRGECO and RCaMPs, can be used
in conjunction with green indicators to record from multiple cell populations with a
single fiber. Some research suggests one can use the same UV-shifted excitation
wavelength to get a calcium-independent signal from these indicators (Supplementary
Note and Fig. 2 in Kim et al., 2016 ). Our experience, generally, corroborates these5

results as the predominant response one sees in the 415nm-related red emission is a
familiar biexponential decay and it is sensitive to motion artifacts.

Identifying motion artifacts with this signal works the same as with green
emission and GCaMP. When thinking about photobleaching, though, things get a bit
trickier. To do so, we have to think about how a green and red signal are recorded
(near) simultaneously. This varies slightly if you are using a V1 (FP3001) or V2 (FP3002)
system but, functionally, their behavior is the same.

5 Kim, C. K., Yang, S. J., Pichamoorthy, N., Young, N. P., Kauvar, I., Jennings, J. H., . . . Deisseroth, K.
(2016). Simultaneous fast measurement of circuit dynamics at multiple sites across the mammalian brain.
Nature Methods, 13(4), 325-328. doi:10.1038/nmeth.3770
Siciliano, C. A., & Tye, K. M. (2019). Leveraging calcium imaging to illuminate circuit dysfunction in
addiction. Alcohol, 74, 47-63. doi:10.1016/j.alcohol.2018.05.013

4 [1] Grain of salt: You would only observe an increase if the effect size was larger than the rate of
photobleaching. Either way, the rate of decrease would decrease.
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This type of photometry setup operates using “time division multiplexing (TDM)”
which is fancy-speak for “alternating.” In a case where we are recording from green and
red indicators, we record one frame with the 415nm LED on, then one frame with the
470nm LED on, then another with the 560nm LED on. This is all happening very quickly
(up to 200 times a second), much faster than any change in the relative emission of the
indicators themselves (100s of ms at the fastest) so, effectively, we are able to record
the resulting emission from three excitation frequencies simultaneously.

On the emission-side, the green and red signals are split by a dichroic mirror and
filtered by respective bandpass filters, before being projected onto different locations
on the camera sensor. This converts a spectral shift into a spatial shift – with one half of
the sensor showing green emission and the other showing red. So, technically, from a
single fiber, we are capturing six distinct readings.

Not all of these are useful. For instance, the green emission when the 560nm LED is on
does not give us information about our underlying biological construct. Same, for the
most part, with the red signal with the 470nm LED on. So, in practice, we are getting6 7

four usable signals from each fiber.

Looking at the above absorption/emission spectra for GCaMP6 and RCaMP1 , we see8

that there is a good portion of the green emission (~500-530nm) where there is no red

8 Genetically Encoded Ca2 Indicators. Biophysical Journal, 116(10), 1873-1886. doi:10.1101/435891

7 Molina, R., Qian, Y., Wu, J., Shen, Y., Campbell, R., Hughes, T., & Drobizhev, M. (2019). Understanding
the Ca2 -dependent Fluorescence Change in Red

6 Some caveats to this in Molina et al., 2019.
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emission; and we chose a bandpass filter to ensure this! GCaMP’s emission, though,
has a super long tail and there isn’t a “clean” section in red where we don’t get some
green signal too.

Using TDM, we can skirt this issue for the calcium-dependent conditions by only
looking at the red signal when the 560nm LED is on. In this case, there isn’t any
GCaMP emission, and we don’t have to worry about crosstalk. But in the
calcium-independent case, 415nm excites both GCaMP and RCaMP. This isn’t an
issue for green, but our red emission does contain some signal from GCaMP. So, what
to do? Luckily the amount of crosstalk is going to be constant and indicator specific.

Calcium-Independent Red = 415nm Signal in Red + X*415nm Signal in Green

(X = fraction of crosstalk)

Functionally, the rate of photobleaching across the two indicators is fairly similar (and
they are being hit with the same power and wavelength light) so one could approximate
the impact of photobleaching by generalizing the 415nm signal in green.

To summarize: The isosbestic signal in the red channel can be used to detect motion
artifacts and, with a few steps, to isolate the contribution of photobleaching to your
signal.

Concluding thoughts:

The 415nm-related emission is a powerful internal control that lets you:

1. Detect motion artifacts

2. Correct for photobleaching

3. Validate observations of slow changes in signal
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Additional Information: Surgery Tips

First, modify your ferrules by cutting / scoring the base
so the glue has something to grip to. This reduces the
risk of a ferrule coming out later in your experiments.
This occurs more with the 2.5 mm ferrules -- but can be
a worry if you need to use an extra tight sleeve with the
1.25s.

Once you have exposed the skull, clean it thoroughly
and dry it. We recommend compressed air (not from a
can!) for this. Then use OptiBond Bonding reagent. This
does 2 things: 1) It chemically etches the skull (i.e. is super corrosive), 2) Once the
solvent evaporates, there is a light-curable compound that creates a porous layer on
top of the skull. This is super useful as you will no longer need screws and your caps
will be much tighter!

This is how it works:

Next, implant your fibers normally.
Use Tetric N-Flow (and little syringe
applicator) to put a small dab at the
base of the ferrule. Use blue light for
~10 seconds to cure. You can buy
one of these things for about $20 on
Amazon. It is very viscous and allows
you to apply the glue focally which is necessary when implanting multiple fibers. You
can then use this to build up the cap properly. Don't make a huge cap and we
recommend putting a little antibiotic ointment at the edges and under the skin. Finally,
use surgical glue to coat the outside of the cap so the skin adheres.
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Implanting 2 fibers takes 30-40 minutes tops. All of these things are available on eBay.
Otherwise, you can get them through a Dentist -- but they might be much more
expensive there.
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How to Cleave Fibers

After deciding on an experimental paradigm, you will need to cleave your fibers to
reach your brain region(s) of interest.  It is vital that the fiber is cleaved properly, as fiber
photometry employs very low levels of light. Proper fiber cleaving ensures the
maximum light power can be emitted.

In order to cleave your fibers, you will need a scribe. We recommend getting them
from Specialized Products. The ruby and carbide versions both work well.  We also
recommend using a ferrule jig when cleaving fibers. We 3D print the ferrule jigs
in-house to help standardize the fiber cleaving process; if you have ordered a system
from us, you likely received one with your system. They allow you to cut fibers in
0.5mm increments from 2mm to 10mm. The jigs eliminate the need for rulers and leave
you with a perfectly cleaved fiber, ready for implantation.

Fibers purchased from Neurophotometrics are sold at 10 mm in length, so they will
need to be cleaved to size dictated by your experimental needs.  Consult a brain atlas
to choose the proper coordinates for your implants. For fiber photometry experiments,
it is very important that the fiber is implanted at the viral injection site. This differs from
optogenetics, where the fiber is usually implanted ~200um above the injection site. We
are working with considerably lower levels of light in fiber photometry than in
optogenetics, so it is important that the fiber is directly implanted in the brain area you
are wanting to record from.  It is important to note that many other factors beyond
target brain regions go into choosing a fiber length as well. These include surgical
method, type of animal subject, and where your target brain region is located relative to
the varying thickness of the skull.

It is imperative that fiber optics meant for brain implantation are flat and polished at the
tip. Jagged, irregular, or slanted tips will diminish the power efficiency and limit the cell
populations that you can reach.  Using scissors, or chopping all the way through the
fiber, will result in a fractured core. A clean and symmetrical cut allows for fluorescent
traces in the nW range to be picked up by your fiber photometry system. Polishing the
tip of your fiber will ensure that the tip is flat and clean. Polishing the tip of the fiber is
not necessary, but highly recommended. Polishing the tip of the fiber will not only
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increase power efficiency but also maximize the collection field below your fiber. A fiber
with a low efficiency will effectively lower your SNR.

How To Cleave with a Neurophotometrics Ferrule Jig
1.     Place the fiber in the well of the ferrule jig that corresponds to your desired
fiber length (the fiber goes into the side of the ferrule with the measurements).

2.     Holding the bottom of the ferrule in place with one finger, lightly score ONE
side of the fiber using the scribe. The pressure applied should be light enough
that the fiber does not snap off, but firm enough to push it up against the side of
the well.

3.     Flick the excess fiber off gently with your finger.

4.     Check the efficiency of the fiber using a power meter to ensure it is about
80%. This can be accomplished by taking a power measurement out of the
patch cord with the fiber attached and dividing it by the power coming out of
just the patch cord (sans fiber). If it is slightly below this threshold (3-4%), you
may lightly polish the fiber by rubbing it gently on polishing paper placed on a
rubber pad.

While the instructions above include the use of a ferrule jig, you can still cleave a fiber
without one. Using the same scribe, tape the ferrule to a ruler and carefully score one
side of the fiber and flick off the excess. All rules still apply — make sure to use gentle
pressure and try not to chop all the way through the fiber.

To mitigate scratches on the ferrule while the animal is in the home cage we
recommend changing the caged lid to a raised caged lid. You can also install dust caps
on the top of the ferrule. However the caps can easily get wedged into the caged lid or
your animal can pull it off. If you have the raised cage lid and no dust cap, you can
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simply clean the ferrule with ethanol and a kim wipe and proceed with your experiment.
For a cleaving instructional video, please visit our website page.
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How to Photobleach Patch Cords

Before recording an experiment, we recommend to photobleach your patch cord
overnight or at least 12 hours every month. Photobleaching your patch cord before a
recording is important as to minimize the effects of photobleaching on your signal.
Photobleaching your patch cord for an extended period of time will inhibit fluorescence
of any fluorescent molecule within the fiber core and cladding. As a result, the rate of
decay is less compared to the rate of decay from an unbleached patch cord.

To photobleach your patch cord, please attach your patch cord to a
Neurophotometrics system. Open Bonsai and insert an FP3002 node into the workflow.
Align your patch cord using the 1-axis translator, for more information please see
section “Connecting and Aligning my Patch Cord on page 23 of this manual. In the
main FP3002 Setup window, under Trigger Sequence, delete the 560 and 415 LED so
that only the 470 LED remains. Then under power, slide the L470 power to 50. Save the
configuration and play the workflow. Please repeat this protocol once every month.

Patch cord bleaching configurations are shown in the image above.

52



Additional Information: Using the Digital Output Port 0

_________________________________________________________________________________________________________

Digital Output Port 0 is a BNC port, enabling the user to send a signal from the
Neurophotometrics fiber photometry system to an external device. The signal can
range from 0V to 5V, either as a HIGH or LOW signal. In order to configure the signal,
you will need to access the Calibration window by double clicking the FP3002 node.
Under the section labelled DigitalIO, click on the drop down menu for DigitialOutput0.
There are 3 preset configurations on this drop down menu, Software, TriggerState
and Strobe.

The Software configuration utilizes the DigitalOutput(Neurophotometrics) node. This
configuration allows Bonsai to act as a function generator via line(s) of code in the
workflow. The DigitialOutput(Neurophotometrics) node will receive input from most
data types and output to the FP3002 node.

In the example above, a signal will output from digital
output port 0 every time the timer completes a cycle.
Within the DigitalOutput node, you can select a
Command. This Command will determine how the
incoming signal will function. For users sending a simple
HIGH/LOW signal to the DigitialOutput node, we highly
suggest using the Set command. Set will set the signal to

HIGH when a sequence is sent to the node. Clear will set the signal to LOW when a
sequence is sent to the node. Toggle will switch the signal from LOW to HIGH and vice
versa when a sequence is sent to the node. Write will set the signal to the state that is
input to the DigitalOutput node. Note that the Mask should always be set to Output0.
A signal dictated by the software can be beneficial for timelocking external behavioural
rigs or controlling an external device such as an external laser or camera.

53



The Strobe configuration does not utilize any external
nodes. Instead the configuration sends a HIGH signal
whenever the camera is acquiring a frame. Selecting
Strobe can be beneficial for timelocking external
devices. The TriggerState configuration will output a
HIGH signal whenever a specified LED is on. Please
select the LEDs to examine on the right hand window
labelled TriggerSequence. In the example on the left, a
HIGH signal is produced every time the 470nm and

560nm LEDs are on. Note that Out1 or Out0 and TriggerState for the respective port
need to be checked and selected in order to output a signal for LED activity. Do NOT
check these boxes if you are not recording the LED trigger state.
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Additional Information: Understanding Frame Flags

_____________________________________________________________________________________________________________________

Frame Flags are a way to understand what
events occurred during a time period in a
recording. Frame Flags can be found in the 3rd
column of a csv file that is saved from the
PhotometryWriter node. The frame flags are
determined by a bitwise shift. The starting
value 1 is shifted by x bits to the left
depending on the state of certain components
of the system. The shift is depicted in the image to the right. Using frame flags can aid
post hoc data processing by noting if a component was simultaneously on while data
was recorded. By using frame flags, you can more efficiently compare fiber photometry
data when the laser was ON versus OFF.

Byte Position Value/No LED ON L415 L470 L560

No additional signal 0 0 1 2 4

Output 1 signal HIGH 3 8 9 10 12

Output 0 signal HIGH 4 16 17 18 20

Stimulation ON 5 32 33 34 36

GPIO Line 2 HIGH 6 64 65 66 68

GPIO Line 3 HIGH 7 128 129 130 132

Input 1 HIGH 8 256 257 258 260

Input 0 HIGH 9 512 513 514 516
Table 1: Frame flags representing when a LED is on simultaneously with an additional
signal.

Above is a table laying out what a frame flag would be if an individual component was
on. As a base the 415nm LED is flagged with value 1, the 470nm LED is flagged with
value 2 and the 560nm LED is flagged with value 4. These values will only change if
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another component on the system was operational simultaneously with an LED. For
example, if the Output0 port was in a HIGH state only while the 415nm LED was ON,
the flag for the 415nm LED would write as 17 while the 470nm LED flag would be 2 and
the 560nm LED flag would be 4. Please note that these values compound. If the
laser(Stimulation) was ON simultaneously with the Output0 port and the 415nm LED,
the flag would write as 49— 1(415nm base value) + 16(bit shift of 4) + 32(bit shift of 5).

More Example Frame Flags
No LED ON L415 L470 L560

No additional signal 0 1 2 4

Output 0 signal HIGH + Stimulation 48 49 50 52

Output 0 signal HIGH + Input 0 signal HIGH 528 529 530 532

Input 0 signal HIGH + Stimulation 544 545 546 548

Output 0 HIGH + Input 0 HIGH + Stimulation 560 561 562 564
Table 2 : Example frame flags when multiple signals are on simultaneously.

The table above shows some example frame flags if many components are on
simultaneously. These values have been calculated by adding the Value of each
specific signal in Table 1 with the LED base value (found in the row labelled “No
additional signal”).
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Bonsai: Basic Bonsai Workflow

_____________________________________________________________________________________________________________________

This basic Bonsai workflow will allow one to
record interleaved fiber photometry data and
record an external web camera and
keystrokes. The first part of this workflow
aims to record your fiber photometry data and
save it into a csv file. The FP3002 node
configures all of your settings such as LED
power levels and Region of Interest (ROI)
definition. Configuration occurs before the
workflow is played. The PhotometryData
node not only passes your data to the
PhotometryWriter, but also populates a
graph of your photometry data in real time. To
view this graph, double left click on the
PhotomeryData node while the workflow is
playing. The automatic Capacity that is
displayed is 300 points. You can change this
by right clicking once on the bottom of the
pop-up window. PhotometryWriter saves all
data into a csv file. The PhotometryWriter
will save the frame number, timestamp, frame
flag, and a normalized average pixel value for
each ROI. Define the save path by left clicking

on the node and selecting FileName under Properties on the right hand side of the
window. PhotometryWriter can save a jpeg of a graph of the entire recording and an
image of your ROIs. The Photometry node is actually a PublishSubject node renamed
as Photometry. PublishSubject casts the information from one node to be used by
another node. This node is crucial if using the WithLatestTimestamp.

The second part of the workflow saves keyboard strokes and the time at which a key
was pressed into a csv file. The KeyDown records when any key on the keyboard was
pressed down. WithLatestTimestamp selectively filters out the timestamp from the
Photometry node. WithLatestTimestamp records the nearest photometry timestamp
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with the input keystroke. The information is passed to the CsvWriter where the key and
timestamp is saved in a csv file. Similarly with PhotometryWriter, save path definition is
found under the properties section of the node. This part of the workflow is great for
note taking, i.e. if an unexpected door slams or to mark behaviour during signal
checks.

The last part of the workflow saves the video from an external web camera and saves
the timestamp of each frame. CameraCapture can pass data from most USB web
cameras. A specific webcam can be specified by inputting a number in Index found
under the Properties section. Note that 0 will most likely be an integrated web camera,
from there each camera will be specified based upon the order that it was plugged in.
VideoWriter will save the video from the CameraCapture as an avi file. Define the save
path under FileName found in the Properties section of the node.
WithLatestTimeStamp and CsvWriter behave similarly to the ones found in the second
section of the workflow. However, the WithLatestTimestamp node will record the
nearest photometry timestamp to each external camera frame. The CsvWriter will only
record the timestamp as the index is indicative of frame number.
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Bonsai: Control LED Activity on TTL

This document discusses a Bonsai Example Code that allows for an external TTL
signal to control the LED activity of the FP system. Using this method, the FP system
will always collect data, but the LED sequence will turn on when a HIGH digital signal is
present on the BNC Digital Input port.

First, double check that your Bonsai Packages are up to date by clicking “Tools ->
Manage Packages…”. This will close your current Bonsai window and open up the
“Bonsai - Manage Packages” window. Check under the updates sections for any
available Neurophotometrics packages that need to be updated.

Once, all your packages are up to date, click the “close” button for the “Bonsai -
Manage Packages” window, and your usually Bonsai window will appear. Now bring a
“FP3002” node into your workflow, specifying the “PortName” value. Double click the
“FP3002” node to open the “FP3002 Setup” window.

In the “FP3002 Configuration” section, find the “Digital IO” menu. Change the value for
“DigitalInput1” to “ControlTrigger”.
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Then connect your TLL signal to the BNC Digital Input 1 port of the system. Once you
press “Start” in the Bonsai code, the LED sequence will turn on while there is a HIGH
signal on the TTL. However, the system will continuously acquire data from the
moment the workflow is started until it is stopped.
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Bonsai:
Triggering the Internal Laser with an External TTL

This document discusses how to trigger the internal laser using an external TTL signal.
The “FP3002” node is actually already set up to handle this so there is no need for a
complicated workflow. First, connect the BNC cable carrying the TTL signal to the “In
1” BNC port of the V2 system. Then, in Bonsai double click the “FP3002” node to open
the “FP3002 Setup” window. Find the “Digital IO” section of the “FP3002
Configuration”. Find the “DigitalInput1” and change its value to “StartStimulation”.
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Next scroll down to the “Stimulation” section and specify the “Laser Wavelength” and
the “Pulse Amplitude”. This will let the system know how bright to shine the laser.

This Bonsai Example Code will collect the interleaved and deinterleaved FP data as
well as the TTL signal/timestamps. The laser will be ON whenever the TTL signal is
HIGH, and OFF when the TTL signal is LOW.

This Bonsai Example Code use the “Photometry Data” node three time, once with no
filter, once with the L415 filter, and once with the L470 filter. This way we can use the
“Photometry Writer” nodes to save three files, one with the full data set, one with the
deinterleaved 415 data, and one with the deinterleaved 470 data.
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We also use the “Digital Input (Neurophotometrics)” node to save the timestamps of
the TTL input. To do this we simply set the “Include Timestamp” value to “True” and
the “Type” value to “Input 1”.
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Bonsai:
External Sensors - Using Arduino

This document discusses how to implement external sensors in an experiment using
Arduino. There are a variety of basic sensors that may be able to provide much needed
data, some examples include: temperature sensors, proximity sensors, accelerometers,
IR sensors, pressure sensors (microphones), voltage/capacitive sensors (lickometers),
etc. Most of the time, these basic sensors output an analog voltage signal. With some
basic wiring to an Arduino microcontroller, we can bring the values measured by these
sensors into Bonsai for data collection purposes.

Arduino microcontrollers are powerful devices, and even the most basic one of the
series, the Arduino Uno, should be more than capable of sending all sensor data to
Bonsai in FP experiments without performance issues. Below is a workflow for setting
up the Circuitry/Hardware:

Circuitry/Hardware:
1. Find out what materials are needed for your setup. You will always need an

Arduino microcontroller (usually an Arduino Uno) and a USB 2.0 Cable Type A/B.
Then depending on what sensor you are using, and your experimental setup you
may need a soldering iron, solder, wiring, BNC Connectors, and/or BNC Cables.

2. Wire the sensor to the Arduino by connecting the sensor’s output pin to the A0
pin of the Arduino and connecting the rest of the pins as the datasheet
recommends. Often this involves connecting the sensor’s ground pin to the GND
pin of the Arduino and connecting the sensor’s positive voltage pin to the +5V
pin of the Arduino. NOTE: Always double check the datasheet of the sensor you
are using to see what you need to connect to what pin. Sometimes, when your
sensor is far away from your computer, it is best to send it through a BNC cable.
For this, you wire the output of the sensor to the positive pin of a BNC connector
and you connect the ground pin of the sensor to the ground pin of the BNC
Connector. Then wire another BNC Connector to the Arduino, with the positive
pin of the BNC Connector to the A0 pin of the Arduino, and the negative pin of
the BNC Connector to the GND pin of the Arduino. Once these BNC Connectors
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are wired to the sensor and the Arduino, you can connect a BNC Cable between
them.

3. After we have set up the circuitry, we must connect the Arduino to the computer
using the USB 2.0 Cable Type A/B.

Once we are confident in our Circuitry/Hardware setup, we can set up the code for our
Arduino. We will use a simple analog firmata code which sends the voltage value on
the A0 pin of the Arduino to the computer. Below are the steps to follow to upload the
code:

Arduino Software:
1. Visit the GitHub link: https://github.com/firmata/arduino
2. Download Zip (in the "Code" drop down menu in the upper right).
3. Open up the Arduino IDE.
4. Click Sketch -> Include Library -> Add .ZIP Library
5. Click on the .ZIP file you just downloaded (should be in your downloads folder)
6. Open the "SimpleAnalogFirmata.ino" ( Click File -> Examples -> Firmata ->

SimpleAnalogFirmata )
7. Check that the Arduino is connected to the Computer via a USB.
8. Click Tools and double check that the "Board:" is filled with the correct board

type (usually Arduino Uno) and that "Port:" is the correct port (should be COMX,
where X is a number).

9. Finally, click the Upload button in the Arduino IDE to upload the code onto your
Arduino.

Once our Arduino is encoded, we can set up our Bonsai code to accept information
from the Arduino. Below are the instructions for setting up Bonsai:

Bonsai Code:
1. Double check you have the Arduino pack downloaded by searching for

"Arduino" in the toolbox search bar.
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2. If no "Arduino" nodes pop up in the toolbox, Click Tools -> Manage Packages.
The Bonsai Workflow will close out and the "Bonsai - Manage Packages"
window will open. Click the "Online" tab on the left and search for "Bonsai -
Arduino Library" in the search bar on the top right. Click it and click install. Once
finished you can close the Manage Packages window and the Bonsai Workflow
window should open back up.

3. Search for "Arduino" in the toolbox search bar and add one "AnalogInput
(Arduino)" node for each analog pin on the Arduino you wish to sample.

4. For each "AnalogInput (Arduino)" node select the pin number you wish to
sample and the port name (Should be the same as the port name you set in the
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Arduino IDE, and should be called something like "COMX" where "X" is a
number). NOTE: Each Arduino Uno setup in this way can read values from six
different sensors at the same time.

5. Once you click start on Bonsai, the ports on the Arduino should be sampled, all
at the same frequency.

6. You can synch this data with the FP data by adding a "Timestamp" node to the
"AnalogInput (Arduino)", then right click the  "Timestamp" node and navigate to
Output -> Timestamp -> TimeOfDay -> TotalMilliseconds.

7. Combine the "TotalMilliseconds" and "Analog Input" nodes in a "ZIP" node and
attach a "CsvWriter".
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Bonsai: Synchronizing Datasets

This document discusses two methods for synchronizing the timestamps of various
datastreams. These methods are used when an experiment requires use of external
cameras, sensors, and/or DAQ boards that must have their data synchronized with the
fiber photometry data. The main difference between the below methods is that one
uses the system’s internal clock to timestamp, while the other uses the computer’s
clock to timestamp.

Computer’s Clock:

Since the “FP3001” and “FP3002” nodes utilize the internal clock of the system, the
timestamp of the “PhotometryWriter” node is always in seconds since the system
turned on. An external camera or a DAQ board does not have access to this
information, so to synchronize the data, we save the Time of Day, Total Milliseconds, of
every frame of the FP data. This way the FP data can be timestamped using a clock
that all other datastreams have access to. So, if we also timestamp all of the
datastreams with Time of Day, Total Milliseconds, then all the data will be synchronized
in time.
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In the example code above, there are three data streams. First is the FP datastream,
which saves the “PhotometryData” using the “PhotometryWriter” node. This is the
standard way of saving the FP data. However, in a parallel stream, we also
“Timestamp” every frame and “Zip” the frame number along with the Time of Day, Total
Milliseconds value, to save to a “.csv”. This way we can have the Computer’s Clock
timestamp of each FP frame to align to the other datasets. The second datastream
records video from an external camera and timestamps every frame. Here you can also
employ video processing techniques (see the “Animal Tracking” documents for more
details). Finally, the third datastream, deals with timestamping a TTL signal using our
DAQ board. Here we timestamp every time the TTL signal changes from HIGH to LOW
or from LOW to HIGH. Here you could also save the raw data from any sensor value
sent from an Arduino. NOTE: Saving the raw data of a sensor can create large file sizes
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because sensors tend to send a lot of data. Since the example is sampling a TTL signal
we first convert the signal to digital using the “GreaterThan” node, and use the
“DistinctUntilChange” so data is only saved when the value changes. For example, an
Arduino Uno can send values of a sensor at ~1250 samples per seconds, so without
the “GreaterThan” and “DistinctUntilChange” nodes, you would be saving 4500000
rows of data per hour of recording in this datastream alone.

The key similarity between each datastream in this code is the use of the “Timestamp”
and “Timestamp. Time Of Day. Total Milliseconds” nodes. This can use the computer’s
clock to timestamp any datastream in Bonsai, making this method quite a robust data
synchronization method.

System’s Clock

Since external cameras, sensors, etc, do not have access to the system’s internal
clock, this method utilizes the “WithLatestTimestamp (Neurophotometrics)” node. This
node will use the latest FP data timestamp as the timestamp for every other
datastream. For example, when a datastream, such as an external camera feed,
pushes an element into the “With Latest Timestamp” node, it will use the latest
timestamp in the FP datastream as the current timestamp for the external camera feed.
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Implementation of this method is quite similar to the computer’s clock method. First,
we must connect the “Photometry Data” node to a “Publish Subject” node and in the
properties for the “Publish Subject”, we must specify the “name” value as
“Photometry”. This “Publish Subject” node is needed for the “With Latest Timestamp”
nodes to have access to the FP timestamps.
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Ultimately, this method synchronizes the datasets much the same as the computer
clock method. However, there are some differences between the two methods. First,
using the system’s clock method, the timestamps of the datasets other than the FP
dataset, will be less accurate. This is because the other datastreams will use the latest
FP data timestamp, which could be several milliseconds before the actual time of
recording for that frame. The accuracy of the FP dataset will not be affected, only the
datasets of the external camera, sensors, etc. Since this accuracy decrease might be
negligible for some experiments, this method is sometimes used to make data analysis
more efficient. This is because every timestamp of every dataset will have their
timestamps line up exactly with a timestamp from the FP dataset.
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Bonsai: Recording Raw Data from the Internal
Camera

This document discusses how to record the raw data from the internal camera of the
system as a “.avi” file. This can be used for post hoc analysis of the images coming
from the system’s camera. First, we start with the standard FP data workflow. Then,
right click the “Photometry Data” node and navigate to “Output -> Image” so that the
“Photometry Data” node has an “Image” node coming from it. Connect the “Image”
node to a “VideoWriter” node to save each frame’s image into a “.avi” file.

Under the “VideoWriter” setting, be sure that the “FrameRate” value is greater than or
equal to the “FPS” of the FP system. This way you do not lose frames in your saved
“.avi” file.

73



Bonsai: Basic Animal Tracking

This document discusses a setup for basic animal tracking while collecting FP data.
The Bonsai Example Code shown below has two datastreams, the animal tracking
datastream and the FP datastream. The FP datastream collects and saves the raw FP
data and deinterleaved FP data, both with timestamps in Time of Day, Total
Milliseconds, so it can be synchronized with the data collected from the animal tracking
datastream. The animal tracking datastream uses the video stream from an external
camera to find the position of an animal in an arena. It saves the centroid of the animal
(in pixels) and the timestamp (in Time of Day, Total Milliseconds) every frame. It also
records the raw video stream and saves it as a “.avi” file for you to reanalyze at a later
time if required.
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Starting with the animal tracking datastream, first we set up the "Video Capture
Device" node, making sure the correct camera is connected. When you have a camera
plugged into your computer via USB, you should see options in the "Index" value of
that node, one will be the camera you want to use the other might be the webcam built
into your computer.

Second, we set up the “Timestamp” nested workflow, this is reused multiple times
throughout the file and is used to timestamp in Time of Day, Total Milliseconds. Create
a “Timestamp” node, right click it and navigate to “Output -> Timestamp -> TimeOfDay
-> TotalMilliseconds”. To put these two nodes in a nested workflow, highlight them and
click “Group”. Below is what the inside of the nested workflow should look like.

Next, create the “Find Centroid” nested workflow. Create the nested workflow shown
below, then we will have to change the values of some of the nodes.
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Take a look at the "Crop Polygon" node, this is what crops the video footage to your
arena. While the Bonsai file is running, Click the "Crop Polygon" node, and then click
the "..." at the right of the "Regions" value.

This will open the video feed from the camera. Now you can crop to your arena by left
clicking and dragging a rectangle in the "Regions" window. If you mess up simply
press delete and try again. Make sure you only have one rectangle, to check this, close
the "Regions" window and click the "+" to the left of the "Regions" value of the "Crop
Polygon" node. Check that there is only one "Point[] Array" value called "[0]". If there is
more than one, (called "[1]", "[2]", ... "[N]"), simply delete the "Crop Polygon" node, add
it again, and retry drawing the regions.

Next, probably one of the most important nodes, is the "HsvThreshold" node, this is
what is used to find the animal in your arena. While Bonsai is running and the animal is
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in the arena, double click this "HsvThreshold" node, you will see a black and white
image of your animal in your arena. You want to adjust the "Lower" and "Upper" values
of this node so that you only see an all-white figure of the mouse. To help with this, you
can double click the "ConvertColor" node to open its visualizer (while the Bonsai file is
still running). If you right click the window, you can see the HSV values of what your
cursor is hovering over in the window. You want only the HSV values of the animal to
be in the "LOWER" to "UPPER" range of the "HsvThreshold" node.
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To double check this is all working properly, while the Bonsai file is running double
click the "CropPolygon" node to open the video feed window. Then click and drag the
"Centroid" node onto the "CropPolygon" window. A green dot will appear in the
window, and it should always be in the center of the animal.

The seconds datastream, which begins with the "FP3002" node, is what collects your
FP Data. In each network node (i.e. "L415 Network'', ... , "Photometry Data Network")
you have your standard "Photometry Data" node (with or without a filter for
deinterleaving) and your standard "Photometry Writer" node.
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This will collect your FP data, however, the "Photometry Writer'' node alone will not
have synchronized timestamps with the animal position data. This is why we have
included a "Time of Day, Milliseconds" node to write the synched timestamp data for
every frame of the FP data. During analysis, you will simply combine the columns of the
"Time of Day, Milliseconds'' data to a matrix containing the "Photometry Writer" data.
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Bonsai:
Animal Tracking, With Multiple Chambers and Laser

Stimulation

This document discusses a Bonsai Example Code that collects FP data while tracking
an animal's position in a multi-chamber arena and stimulating when the animal enters a
specified chamber.
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We begin with the "VideoCaptureDevice" node, and specify the "Index" value of your
external camera.

Then you must make changes to some nodes inside the "Chamber1", "Chamber2",
"FindCentroid", and "FP" nested workflow nodes. Start by creating the nested
workflows shown below. Connect them as you see in the “Workflow” screenshot
above.
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We will need to change the values of some of these nodes while the Bonsai file is
running. So, for now, disable all of the writer nodes as well as the "FP" nested
workflow. This way you do not save a ton of .csv and .avi files nor flash the laser
while you adjust the parameters of the Bonsai code for your particular setup.

Now navigate inside the "Chamber1" node, this is the chamber that will trigger the
laser when the animal enters it. Here, we first need to specify the "Regions" value of
the "CropPolygon" node.

While the Bonsai code is running, click the "..." in the "Regions" value of the
"CropPoly" node inside the "Chamber1" nested workflow. This will pop open a window
for you to crop the video to only analyze the chamber that will trigger the laser. Left
click and drag a rectangle around the region of interest, making sure not to have any
extra clicks.
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When completed, check the "Regions" value, press the "+" to extend to see your ROI
values. Double check that there is only one labeled "[0]". Also double click the
"CropPolygon" node to make sure that you see only the chamber that will trigger the
laser.
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Now you must adjust the values of the "HsvThreshold" node in the "Chamber1" nested
workflow. This is the node that is used to find the animal in your arena. It turns every
pixel of the video feed inside the specified HSV range to white, and every pixel outside
the HSV range to black. You want this to output an image that is all black except for the
animal which is all white. While the Bonsai file is running, double click the
"HsvThreshold" node to see what it is outputting, and change its values until you only
see the animal in all white, with an all black background.
Note: if you are having issues finding the correct HSV values, double click the
"ConvertColor" node while the Bonsai is running to see the video feed in HSV color
domain. Then right click that "ConvertColor" popup window, and in the bottom right it
will tell you the current HSV value of the pixel that your cursor is hovering over. This will
help you know what HSV values correspond to the color of your animal and what HSV
values correspond to the color of the arena/chamber.

Make these same changes to the "Chamber2" nested workflow. Then for the
"FindCentroid" all you need to change is the "HsvThreshold" values, since there is no
"CropPolygon" node. Note: The values of ALL of the "HsvThreshold" nodes will
probably be quite similar, so you might be able to get away with simply copy and
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pasting the values from the "HsvThreshold" node in the "Chamber1" nested workflow,
to the other two "HsvThreshold" nodes.

One last node to setup is the “Python Transform” node within the “FP” nested
workflow. This node works as a count and has a simple script shown below. Simply
double click the “Python Transform” and enter the script below.

Once the code is all set up to track the animal position and which chamber it is in,
go ahead and enable the "FP" nested workflow and double click the "FP3002" node to
set the parameters for the V2 system (especially the “stimulation” parameters). Then go
to all of the writers and specify the file names. When this is all set up you will save 4
files. The first contains the normal FP data from the "PhotometryWriter". The seconds
contains the timestamp of every FP frame in Time of Day, Total Milliseconds as well as
the frame count (this way you can synchronize the FP frames with the external camera
frames). The third has the first column saying if the animal is in chamber 1, the second
column saying if the animal is in chamber 2, the third column saying the x position of
the animal, the fourth column saying the y position of the animal, and the fifth column
saying the timestamp in Time of Day, Total Milliseconds. Finally, the fourth file is the
raw .avi (video file) from the external camera so you can reanalyze it at a later date,
should the need arise.
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Bonsai: Start Data Acquisition On TTL Input

This document discusses a Bonsai Example Code that allows for an external TTL
signal to control the data acquisition of the FP system. Using this method, the FP
system will only collect data when a HIGH digital signal is present on the BNC Digital
Input port.

First, double check that your Bonsai Packages are up to date by clicking “Tools ->
Manage Packages…”. This will close your current Bonsai window and open up the
“Bonsai - Manage Packages” window. Check under the updates sections for any
available Neurophotometrics packages that need to be updated.
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Once, all your packages are up to date, click the “close” button for the “Bonsai -
Manage Packages” window, and your usually Bonsai window will appear. Starting with
the “FP3002” node, specify the “PortName” value and double click the node to open
the “FP3002 Setup” window.

In the “FP3002 Configuration” section, find the “Digital IO” menu. Change the value for
“DigitalInput1” to “EventChange”.
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Then we put a “Command Subject” node before the “FP3002” node, and a “Sink” node
after, which we name “TriggerControl”

Now we must configure the “Trigger Control” node as shown below.
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The “DigitalInput.Input1” node is the “Digital Input (Neurophotometrics)” node with the
“Type” value as “Input 1”.

The “Start” and “Stop” nodes are “Condition” nodes with “Start” and “Stop” values for
the “Name”.
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Below are the values you must specify for each “Create Message” node after the
“Start”, “Stop” and “Take” nodes (in that order).

After the “Merge” node is a “MulticastSubject” node with the “Name” value as
“Command”.
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Now that the “TriggerControl” node is configured, we can move on to the second half
of the program shown below.

After the “Photometry Data” we create a “Publish Subject” node and name it “Data”.
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Then in a separate data stream we make a “Subscribe Subject” with the exact same
name of “Data”. After the “Subscribe Subject” is the “First” node, then right click the
“First” node and navigate to “Output -> Activity -> Length”. End the datastream with a
“Select Many” node with the values below.

All that is left is the “Timestamp” datastream coming from the “Photometry Data” node.
Where we “Zip” the frame count and Time of Day, Total Milliseconds outputs from the
“Timestamp” node and save to .csv.

92



Once the Bonsai code is configured then connect your TLL signal to the BNC Digital
Input 1 port of the system. Once you press “Start” in the Bonsai code, the system will
only acquire data while there is a HIGH signal on the TTL.
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Bonsai: TTL Synchronization

This document discusses a Bonsai Example Code that allows for the timestamps of the
FP system to synchronize with external devices via a TTL signal. We attach a BNC
cable carrying the TTL signal from another device to the Digital Input 1 of the FP
system. Then we can timestamp that TTL signal and the FP data frames using the
same clock.

94



The Bonsai code above has two data streams coming from the “FP3002” node. The
top data stream timestamps the TTL signal coming into the Digital Input 1 of the FP
system using the Time of Day, Total Milliseconds method.

The bottom data stream uses the “Photometry Writer” node to save the FP data.
However, this node timestamps using the FP system’s internal clock, while the Time of
Day, Total Milliseconds method timestamps using the computer’s internal clock. So, we
also use a “CsvWriter” node to save the timestamps of each FP data frame using the
computer’s clock. This way the timestamps of the TTL signal and FP data are aligned.
You can take this method of timestamping further by timestamping any datastream
using the Time of Day, Total Milliseconds (i.e. “Video Device Capture”, “Analog Input
(Arduino)”, etc.). Bringing in all of the experimental data to Bonsai and using this
timestamping method allows for all the data sets to be timestamped using the same
clock, causing the data to be aligned.
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Bonsai: Timer Delayed Data Acquisition

This document discusses a Bonsai Example Code that allows for photometry data
acquisition to be delayed by a specified amount of time. Starting with a basic setup of
using a “FP3002” node connected to a “Photometry Data”node, specify the
“PortName” and set the “AcquisitionMode” to “StopPhotometry”. This current setup will
not acquire photometry data until it is commanded to do so.

To command the “FP3002” node to “StartPhotometry” after a specified amount of time,
we must use a “Timer” node connected to an “AcquisitionControl” node.

Now, we want the “Acquisition Control” node to command the “FP3002” node to “Start
Photometry” after a specified amount of time. So in the “Acquisition Control” properties
menu, set the “Mode” to “Start” and the “Streams” to “Photometry”. This means that
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once the “Acquisition Control” node is passed a value (almost any value), then it will
command the “FP3002” node to start collecting photometry data. To have this occur
after a specified amount of time, we simply set the “Due Time” value of the “Timer”
node to the amount of time we want. In the case below, we start acquiring photometry
data 10 seconds after we click start on the Bonsai program.
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Bonsai: ROI Visualizers

This document discusses a Bonsai
Example Code allows the user to separate
the ROI data such that the data for each
ROI is on a separate visualizer graph.

Setting up our ROIs, double click the
“FP3002” node to open up the “FP3002
Setup” window. Then click the “Calibrate
Regions”, to open the “Calibrate
Regions…” window, slide the “Power (%)”
bar up.

Now we can click the “Calibrate Regions”
button in this window to open the
“Regions” window. Here you want to click
and drag to create oval ROIs in the cores of your
patch cord.

Now, when we click “Start” on the Bonsai file, and
double click the “Photometry Data” node to open its
visualizer window, we see that all of the ROIs are on
one plot. This is normal, but below is a method for
how to separate each of these ROI plots into their
own windows.
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Using the “ROI Visualizer” nested workflows, we can approximately recreate what the
“FP3002” and “Photometry Data” nodes do to acquire data from the ROIs. Enter the
“ROI Visualizer” nested workflows by double clicking each of them. The only thing that
needs edited in these nested workflows are the “Crop Polygon” nodes.

The “Crop Polygon” nodes are going to crop the incoming images to your ROIs,
however, we will need light for this to be doable. So open up the “FP3002 Setup
window, and under “Power”, change the L470 value to 100. In the “Trigger Sequence”
menu, delete the “L560” and “L415” rows as shown below.
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Now, click “Start” to run the Bonsai file, navigate inside an “ROI Visualizer” nested
workflow, and click on the “Crop Polygon” node. Click on the regions value under
“Properties” and click the “...”
symbol to open up the “Regions” window.

We see the same “Regions” windows from before when we were setting up our ROIs
for the “FP3002” node. Now we need to recreate each ROI, one ROI per “ROI
Visualizer” node. To draw these as ovals, you must Shift Click and drag to size.
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Once all of the “Crop Polygons” are setup properly we can see the effect of this by
double clicking each “ROI Visualizer” while the Bonsai file is running:
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Bonsai: Start Stimulation After “X” TTL Pulses

This document discusses a method for activating the internal laser after X number of
pulses from a TTL input.

We start our workflow with a “Command Subject” node connected to a “FP3002” node
and a “Sink” node. This is the basic setup for any feedback related Bonsai code. We
will use the “Sink” to send a command back to the “Command Subject” node and thus
back to the “FP3002” node. Within the “Sink” node we take in the “Digital Input. Input
1” value which reads the TTL signal on the Digital Input 1 port of the System. Then
alternate between “Python Transform” and “Distinct Until Changed” nodes to format
the data stream so that the “Stimulation. Start” node sends commands to start
stimulation at the appropriate times.
The first “Python Transform” node contains the script below which counts how many
TTL pulses have been read, returning a “1” when it has counted the desired number of
pulses and “0” otherwise.
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The first “Distinct Until Changed” will then only output a value when it changes, giving
you a datastream of 0, 1, 0, 1, …, 0, 1, instead of “X” amount of zeros between each
one.
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Keep in mind that the “Command” node, in this case, the “Stimulation. Start” node,
sends its command every time a value is passed to it. So we want to only have the “1”s
being passed to it. So we chain another “Python Transform” counter node in
combination with another “Distinct Until Changed” node so the value only changes
when a “1” is passed, meaning that a value is only passed from the “Distinct Until
Changed” node to the “Stimulation. Start” node when “X” amount of TTL pulses have
been read. Below is the script used for the second “Python Transform” node.

We include a “Skip” node with a “Count” value of “1” so that the first value passed
from the second “Distinct Until Changed” node is skipped, otherwise the laser will
trigger its first laser pulse train immediately on start. With the “Skip” node, the first
laser pulse train does not occur until the first “X” number of TTL pulses. Then the laser
stimulation re-triggers after another “X” number of TTL pulses, repeating.

After the “Stimulation.Start” node, we use a “Multicast Subject” node with a “Name”
value of “Command” to send the stimulation command to the “Command Subject”
node.
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Finally, double click the “FP3002” node to open the “FP3002 Setup” window. Double
check that the “Digital Input 1” value is set to “Event Rising”, otherwise the logic in our
“Sink” node will need to be changed. Then specify the “Stimulation” settings.
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Bonsai: Using Real-Time FP Data to Trigger Laser
Stimulation

This document discusses how to use spikes in the FP data to trigger laser stimulation.
We create a feedback loop in Bonsai that can send a “Start Stimulation” command to
the “FP3002” node when FP data from one or more of the ROIs rise above a certain
threshold.
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First, we must properly set up our ROIs in the “FP3002” node and within the “ROI
Visualizer” nested workflows. Please read the “ROI Visualizers” documentation on how
to set these up. Once the ROIs and ROI visualizers are properly implemented, we
choose which ROI to use as a trigger for the laser stimulation. In the example case, we
use ROI 0 to trigger the stimulation by connecting it to a “Sink” node.

The “ROI Visualizer 0” node sends the raw FP data from ROI 0 into the “Sink” nested
workflow shown above. The “Greater Than” node thresholds the raw value, outputting
a “1” when the FP data is above the threshold, and a “0” when below the threshold. In
the example case we want values above 150 to trigger the laser, change the “Value”
value of the “Greater Than” node to your desired threshold.
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Since brain activity is spontaneous and the noisy signal can occasionally jump above a
threshold without a neural event, we use a “Python Transform” node to keep track of
the last “N” FP data values and we only stimulate if all of the previous “N” values are
above the threshold. In the example code, we only trigger laser stimulation after “N”
successive values are above the specified threshold. To change this, double click the
“Python Transform” node to open up the “Python Script” window and change the value
of “N” to your desired amount of samples. This first “Python Transform” node will
return a “1” when ALL of the previous “N” values are above the threshold and a “0”
otherwise.
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This allows us to use a similar counter method as in the “Starting Stimulation After X
TTL Pulses” document, to format the data so that the “Stimulation. Start” node only
sends a command when “1”s are passed through to it. So we follow the first “Python
Transform” node with a “Distinct Until Changed” node so that we have a data stream in
the form of 0, 1, 0, 1, ... , 0, 1, instead of having an arbitrary amount of zeros in
between each 1. Next comes the seconds “Python Transform” node that acts as a
counter adding each successive value being passed through it as shown below.
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Since the value coming out of the “Python Transform” node only changes when a “1” is
passed through it (i.e. when there is a spike in FP data) then we can use a “Distinct
Until Changed” node so that a value is only passed to the “Stimulation. Start” node
when there is a spike in FP data. We include a “Skip” node with a “Count” value of “1”
so that the laser does not trigger immediately upon start. We use a “Multicast Subject”
node with a “Name” value of “Command” to send the “Stimulation. Start” command
back to the “Command Subject” node so that the “FP3002” node knows to begin
stimulation. Ultimately, this code allows us to trigger the stimulation after a spike in FP
data. One can expand upon this workflow by including more sophisticated event
finding algorithms in the first “Python Transform” node.

Once the threshold and number of samples have been specified, then all that is left is
setting up the “Stimulation” settings inside of the “FP3002” node.

Now, once the Bonsai code is started, spikes in the FP data will trigger the laser
stimulation. To expand this technique, one can implement more sophisticated real-time
event finding algorithms within the “Python Transform” node such as a calibrated
running-average or curve-finding techniques.
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Bonsai: Timer Controlled Internal Laser Stimulation

This document discusses how to use a timer to control the triggering of laser
stimulation. For instance, when implementing this code, the laser will start OFF, wait
“X” amount of seconds, pulse according to the “Stimulation” settings for “X” amount of
seconds, turn OFF for “X” amount of seconds, and repeat in this manner until the code
is stopped.

We start with a "Timer" node and specify values for the "Due Time" and the "Period".
The "Due Time" will dictate how long it will take until the first laser pulse train. Then the
"Period" will dictate how long to have the laser pulse train run and how long to have it
stopped for. So in the example, we have set both value to 10 seconds meaning the
laser will start OFF for 10 seconds, then ON for 10 seconds, then OFF for 10 seconds,
etc.
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The "Python Transform" node formats the data coming from the "Timer" node so that
the "Stimulation. Control" node will command the "FP3002" node to trigger the laser in
this way.

All that is left is to connect the "FP3002" node in the standard datastream for data
acquisition ("FP3002" -> "Photometry Data" -> "Photometry Writer") and to set up the
"FP3002" node configuration by specifying the "Stimulation" settings.
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Introduction to Analyzing Your Data (MatLab)

Importing data into MATLAB

To import your data into MATLAB, click on “Import Data” in the toolbar.

The FP data are stored as a csv file (comma separated value) so make sure MATLAB
knows this by selecting “Delimited” and “Comma.” Lastly, output the data as a
“Numeric Matrix.”
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Data formatting

There are a few ways to save your photometry data. While it is useful to deinterleave
your data in Bonsai for visualization, we recommend saving the non-deinterleaved file.
It makes analysis easier down the road.

The data themselves are pretty intuitive. For every frame, we save a packet of
information letting you know when that frame was collected, which LEDs were on, and
your signal.

FrameCounter: Sequentially counts the number of frames collected
during an experiment.

Timestamp: Time when a frame was recorded using the internal
clock in the FP3002 (<5us precision).

Flags: The flag indicates the internal state of the FP3002 when a
frame was captured.

RegionXG: Mean pixel value within the confines of the
user-selected region of interest (ROI) on the half of the image
sensor that captures green emission. Note: These data are
normalized as the fraction of the maximum value, so the range is
0-1. X is an integer starting at 0.

RegionYR: Mean pixel value within the confines of the
user-selected region of interest (ROI) on the half of the image
sensor that captures red emission. Note: These data are
normalized as the fraction of the maximum value, so the range is
0-1. Y is an integer starting at 0.

It is important to familiarize yourself with what “raw” photometry data look like. To do
this, plot the data from one of your ROIs. No need to worry about an X value.

plot(data(:,4))
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This is an example of a dataset with a high signal-to-noise ratio (SNR) in a brain region
with quite a bit of spontaneous (and evoked) activity. Subplots A, B, and C are zoomed
in versions of the same data.
Looking at A, we see there are two parts of the data -- the lower part where we see a
lot of activity and the upper part that is relatively flat. Zooming in further, with B, it
becomes even clearer and we can observe the telltale asymmetrical kinetics of GCaMP
(in this case, 6s). Faster rise. Slower decay. Zooming in even further, with C, we can
see that every-other-datapoint is either from the group with signal (lower group, in this
case) or without (higher group, in this case).

With this dataset, researchers were oscillating between 415nm stimulation and 470nm
stimulation resulting in a calcium-independent (415mm, upper group) and
calcium-dependent (470nm, lower group) data streams.

Subsequent analyses will deinterleave these data using the “flags” variable. For
example:

plot(data(data(:,3)==18,4)) %plots all data from column 4 (in our case, ROI0G, where
the flag value was 18 indicating that the 470nm LED was on; data plotted in A below)
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plot(data(data(:,3)==17,4)) %plots all data from column 4 (in our case, ROI0G, where
the flag value was 18 indicating that the 415nm LED was on; data plotted in B below)

Just by looking through the deinterleaved data, without any fancy post-hoc analyses,
we can glean a tremendous amount of useful information.
Note: You can have bonsai save a chart of your deinterleaved data. This is not only
useful for all the reasons detailed below, but allows you to quickly scan through files
(without opening MATLAB or any analysis software) so see what your signal looks like.

ALWAYS ALWAYS ALWAYS SCAN THROUGH DE-INTERLEAVED DATA FROM ANY
PHOTOMETRY RECORDING.
For reference, here is a checklist of what to look for in raw, deinterleaved, data.

● Do we have good signal?
○ Look at the 470 data and see if there are clearly defined peaks.

■ Do they have asymmetrical kinetics?
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● For calcium indicators, the rise time is always faster than the
decay time and this is reflected in the photometry signal.

● Dopamine indicators, in our experience, have more
symmetrical rise and decay kinetics.

■ Do they appear “smooth”?
● This is an indication of a high SNR as the signal is so large

that the data scale to wash out the noise. You can visualize
this in Bonsai live too!

● There are always exceptions. If you have a brain region with
a very low mean firing rate (locus coeruleus and the dentate
gyrus, for example) this can result in a fairly noisy flat signal
with clearly defined peaks on top of it.

○ Find a large peak in the 470 and look at the corresponding 415 signal.
■ Do they look identical? If so, this is bad news and your signal is

likely artifactual. Check additional peaks to confirm. Note: It is rare
for a signal to have your expected kinetics and be artifactual -- but
not impossible.

■ Is the 415 signal flat? Great! Your signal is likely real!
■ Does the 415 look like an inversion of your 470 signal? Double

great! See section on the isosbestic point for more details.
● Was there a lot or a little spontaneous activity?

○ For the majority of brain regions, recording over 10 minutes or so, you’ll
see some sort of spontaneous activity. This results in the 470 signal
looking “busier” than the 415.

○ Are there periods with no activity? Or: Does there appear to be a signal
floor?

■ This becomes important when correcting for photobleaching. With
some regions, there is so much spontaneous activity that it
becomes very hard to estimate baseline (most interneurons in
cortex, for example). Take note of this. The more spontaneous
activity you observe, the longer the recording needs to be to
estimate baseline and correct for photobleaching.

● Was there substantial photobleaching during the recording?
○ Check out the decay of the 415 signal. Can it be explained by a

biexponential decay?
○ Were there many motion artifacts?
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■ This would appear as a transient deviation in your signal that is
clearest in the 415nm signal. Most often, it presents as a decrease
with symmetrical kinetics that exceed the kinetics you would
expect with your indicator. See red arrows for an example.

○ Are there discontinuities in the 415 channel? Does it appear to jump
(step-wise) from one value to another?

■ This is often an indication that the patch cord became
disconnected from the animal during the recording or it was
damaged. Mice can chew through patch cables if unsupervised.

Strategies

There are various strategies one can take once the data is scanned through, depending
on the purpose of the experiment. We outline the most common one below.

1. Correct data for photobleaching
2. Align data to some event
3. Chop data up about said event
4. Profit

Correcting for photobleaching: The importance of this step is a function of the light
power used during the experiment as well as the duration of the recording. For
example, a five minute recording with 30uW of light will probably have negligible
bleaching effects. Even if that is the case, always take bleaching into consideration!

There are a couple of approaches out there. This is the one we recommend for 90% of
datasets.

1) Fit isosbestic with biexponential decay
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2) Linearly scale that fit to the calcium
dependent data (using Robust Fit)

3) Divide your raw 470 data by the scaled fit
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